The information in this manual is subject to change without notice and should not be construed as a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this manual.

Except as may be expressly stated anywhere in this manual, nothing herein shall be construed as any kind of guarantee or warranty by ABB for losses, damages to persons or property, fitness for a specific purpose or the like.

In no event shall ABB be liable for incidental or consequential damages arising from use of this manual and products described herein.

This manual and parts thereof must not be reproduced or copied without ABB's written permission.

Additional copies of this manual may be obtained from ABB.

The original language for this publication is English. Any other languages that are supplied have been translated from English.

© Copyright 2008 - 2020 ABB All rights reserved.
ABB AB
Robotics Products
SE-721 68 Västerås
Sweden
## Table of Contents

1 Release Information 6

1.1 General 6

1.2 System recommendation 7

2 What’s new in RobotStudio 2019.5.5 9

2.1 Support for RobotWare 7.04 9

3 What’s new in RobotStudio 2019.5.4 10

3.1 Support for RobotWare 7.03 10

4 What’s new in RobotStudio 2019.5.3 11

4.1 Output signals can be used as input to logic expressions in Visual SafeMove 11

5 What’s new in RobotStudio 2019.5 12

5.1 Jogging the real IRB 910INV from RobotStudio 12

5.2 Confirmation when connecting to controller with later RobotWare version 13

5.3 New robot model 13

6 What’s new in RobotStudio 2019.4 14

6.1 Search file in Options dialog 14

6.2 IBT 6790: Cable and contactor added 15

6.3 Trial license for PowerPacs 16

6.4 Support tool available from the Help menu 16

6.5 Support for RobotWare 5.16 16

7 What’s new in RobotStudio 2019.3 17

7.1 Support for RobotWare 7 and OmniCore 17

7.2 New robots 18

7.3 Other changes 19
# Table of Contents

## 8 What’s new in RobotStudio 2019.1

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.1 Changes to naming and licensing</td>
<td>20</td>
</tr>
<tr>
<td>8.2 The term ‘System’ replaced by ‘Virtual Controller’</td>
<td>20</td>
</tr>
<tr>
<td>8.3 RobotWare must be installed separately</td>
<td>21</td>
</tr>
<tr>
<td>8.4 Other changes</td>
<td>21</td>
</tr>
</tbody>
</table>

## 9 Late changes

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.1 Late changes in RobotStudio 2019.5.3</td>
<td>22</td>
</tr>
<tr>
<td>9.2 Late changes in RobotStudio 2019.4</td>
<td>22</td>
</tr>
<tr>
<td>9.3 Late changes in RobotStudio 2019.3</td>
<td>23</td>
</tr>
<tr>
<td>9.4 Late changes in RobotStudio 2019.2</td>
<td>23</td>
</tr>
</tbody>
</table>

## 10 CAD import formats and versions

## 11 Corrections

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.1 Corrections made in 2019.5.</td>
<td>27</td>
</tr>
<tr>
<td>12344</td>
<td>27</td>
</tr>
<tr>
<td>11.2 Corrections made in 2019.5.4</td>
<td>27</td>
</tr>
<tr>
<td>11.3 Corrections made in 2019.5.3</td>
<td>27</td>
</tr>
<tr>
<td>12344</td>
<td>28</td>
</tr>
<tr>
<td>12345</td>
<td>28</td>
</tr>
<tr>
<td>12346</td>
<td>28</td>
</tr>
<tr>
<td>11.4 Corrections made in 2019.5.2</td>
<td>28</td>
</tr>
<tr>
<td>11.5 Corrections made in 2019.5.1</td>
<td>28</td>
</tr>
<tr>
<td>11.6 Corrections made in 2019.5</td>
<td>28</td>
</tr>
<tr>
<td>11.7 Corrections made in 2019.4 SP1</td>
<td>29</td>
</tr>
<tr>
<td>11.8 Corrections made in 2019.4</td>
<td>29</td>
</tr>
<tr>
<td>11.9 Corrections made in 2019.3</td>
<td>30</td>
</tr>
<tr>
<td>11.10 Corrections made in 2019.2</td>
<td>31</td>
</tr>
<tr>
<td>11.11 Corrections made in 2019.1</td>
<td>32</td>
</tr>
</tbody>
</table>
# Table of Contents

## 12 Known Limitations

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.1 Visual SafeMove</td>
<td>33</td>
</tr>
<tr>
<td>12.2 Online</td>
<td>33</td>
</tr>
<tr>
<td>12.2.1 Online – Paint</td>
<td>34</td>
</tr>
<tr>
<td>12.2.2 Online – Integrated Vision</td>
<td>34</td>
</tr>
<tr>
<td>12.3 Offline</td>
<td>37</td>
</tr>
<tr>
<td>12.3.1 Conveyor Tracking</td>
<td>39</td>
</tr>
<tr>
<td>12.3.2 MultiMove</td>
<td>40</td>
</tr>
<tr>
<td>12.3.3 External Axis</td>
<td>40</td>
</tr>
<tr>
<td>12.3.4 Network Drives and UNC Paths</td>
<td>41</td>
</tr>
<tr>
<td>12.3.5 RAPID</td>
<td>41</td>
</tr>
<tr>
<td>12.3.6 Paint</td>
<td>42</td>
</tr>
<tr>
<td>12.3.7 Graphics and Geometry</td>
<td>42</td>
</tr>
<tr>
<td>12.4 ScreenMaker Limitations</td>
<td>43</td>
</tr>
</tbody>
</table>

## 13 RobotWare Compatibility

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>13.1 General</td>
<td>46</td>
</tr>
<tr>
<td>13.2 RobotWare 5.05 and 5.06 Compatibility</td>
<td>46</td>
</tr>
<tr>
<td>13.3 RobotWare 5.07 Compatibility</td>
<td>46</td>
</tr>
<tr>
<td>13.4 RobotWare 5.08 Compatibility</td>
<td>46</td>
</tr>
<tr>
<td>13.5 RobotWare 5.10 Compatibility</td>
<td>46</td>
</tr>
<tr>
<td>13.6 RobotWare 5.11 Compatibility</td>
<td>46</td>
</tr>
<tr>
<td>13.7 RobotWare 5.12 Compatibility</td>
<td>47</td>
</tr>
<tr>
<td>13.8 RobotWare 5.13 Compatibility</td>
<td>47</td>
</tr>
<tr>
<td>13.9 RobotWare 5.15 Compatibility</td>
<td>48</td>
</tr>
<tr>
<td>13.10 RobotWare 6 Compatibility</td>
<td>48</td>
</tr>
<tr>
<td>13.11 General Compatibility Limitations</td>
<td>48</td>
</tr>
<tr>
<td>13.12 ScreenMaker Compatibility</td>
<td>48</td>
</tr>
</tbody>
</table>
# 1 Release Information

## 1.1 General

### Release Name

The release name is RobotStudio 2019.5.5 and the build number is 7.0.8747.636.

### User documentation

The RobotStudio Operating Manual is available in all languages except Czech, i.e. English, German, French, Korean, Chinese, Japanese, Spanish.

A selected set of RobotWare manuals are available. Each of them is available in two versions, one for IRC5 and one for OmniCore. The OmniCore manuals are only available in English.

### Release Date

The release date is May 14th, 2020.

### Demo stations

The following demo stations are included in this version.

- Demo AW Station
- Demo Solar Simulation
- Demo Exhaust Pipe
- Demo FlexLoader
- SC demo station finished.rspag
- SC demo station start.rspag

They are stored in the Pack & Go format (.rspag) and can be opened with the command Unpack & Work on the Share section of the RobotStudio menu.

### ScreenMaker Demo Station and Project

There is a demo station and associated ScreenMaker project available.

- SCM_ExampleProject *(ScreenMaker Project)*
- SCM_ExampleStation *(RobotStudio station)*

These files are found in the ‘Addins/ScreenMaker/Samples’ folder under the RobotStudio installation folder.

### Tutorials

1.2 System recommendation

Recommended Software

<table>
<thead>
<tr>
<th>Operating System</th>
<th>5.06 to 5.16.x</th>
<th>5.60.x and 5.61.x</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows 7 SP1</td>
<td>64-bit edition</td>
<td></td>
</tr>
<tr>
<td>Microsoft Windows 10 Anniversary update or later</td>
<td>64-bit edition</td>
<td></td>
</tr>
<tr>
<td>ABB RobotWare 5 for IRC5</td>
<td>5.06 to 5.16.x</td>
<td>5.60.x and 5.61.x</td>
</tr>
<tr>
<td>ABB RobotWare 6 for IRC5</td>
<td>6.0 to 6.10.x</td>
<td></td>
</tr>
<tr>
<td>ABB RobotWare for OmniCore</td>
<td>7.0.x</td>
<td></td>
</tr>
</tbody>
</table>

1 The virtual OmniCore FlexPendant requires Windows 10 and does not work on Windows 7
2 The Windows AppInstaller is a pre-requisite for the virtual OmniCore FlexPendant software, see https://www.microsoft.com/en-us/p/app-installer/9nblggh4nns1. The App Installer is a default built-in app in Windows 10, but may have been removed on some PCs.
3 Sidelooning of apps must be enabled on Windows 10 to install the virtual OmniCore FlexPendant, see below

It is recommended to run Windows Update to get the latest updates to Windows prior to installing and running RobotStudio. This applies to any of the operating systems above.

Note

The Windows Firewall will try to block features necessary to run RobotStudio. Make sure to unblock these features when asked (Industrial Robot Discovery Server, RobotStudio StudioAppFramework module, Virtual RobotController (all published by ABB)). The blocking state of a certain program can be viewed and changed at Start/Control Panel/Windows Security Center/Windows Firewall. Read more on http://www.microsoft.com.
Recommended Hardware

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>2.0 GHz or faster processor, multiple cores recommended</td>
</tr>
<tr>
<td>Memory</td>
<td>8 GB minimum 16 GB or more if working with large CAD models</td>
</tr>
<tr>
<td>Disk</td>
<td>10+ GB free space, solid state drive (SSD)</td>
</tr>
<tr>
<td>Graphics card†</td>
<td>High-performance, DirectX 11 compatible, gaming graphics card from any of the leading vendors. For the Advanced lightning mode Direct3D feature level 10_1 or higher is required.</td>
</tr>
<tr>
<td>Screen resolution</td>
<td>1920 x 1080 pixels or higher is recommended</td>
</tr>
<tr>
<td>DPI</td>
<td>Normal size (100% / 96 dpi) up to Large size (150% / 144 dpi) Only Normal size supported for Integrated Vision.</td>
</tr>
<tr>
<td>Mouse</td>
<td>Three-button mouse</td>
</tr>
<tr>
<td>3D Mouse [optional]</td>
<td>Any 3D mouse from 3DConnexion, see <a href="http://www.3dconnexion.com">http://www.3dconnexion.com</a>.</td>
</tr>
</tbody>
</table>

† A note on graphics cards and PC hardware. RobotStudio will not benefit from the additional features of so-called ‘Professional’ or ‘Workstation’ graphics cards. The price level of these are at a much higher range than gaming graphics cards with comparable performance. High-end gaming PCs are very suitable for offline programming with RobotStudio. Such a PC will provide good performance for a limited budget.
2 What's new in RobotStudio 2019.5.5

2.1 Support for RobotWare 7.04

Overview

This is a maintenance release with support for RobotWare 7.04.
3 What’s new in RobotStudio 2019.5.4

3.1 Support for RobotWare 7.03

Overview

This is a maintenance release with support for RobotWare 7.03.
4 What’s new in RobotStudio 2019.5.3

4.1 Output signals can be used as input to logic expressions in Visual SafeMove

Overview

The output of one supervision function can be used as input for activation of another supervision function. In a logic expression the output signal can be used as an input signal to the same expression.
5 What’s new in RobotStudio 2019.5

5.1 Jogging the real IRB 910INV from RobotStudio

Overview

Robot Control Mate is a RobotStudio add-in for operation and commissioning of the SCARA robot IRB910INV in Auto mode without a FlexPendant.

It supports IRB910INV and can only be used for OminCore controller with RobotWare 7.

For the robot controller to work without a FlexPendant the option 3018-1 Hot swappable FlexP must selected in RobotWare. If the option is not selected, and the FlexPendant is disconnected, it will result in an emergency stop.

Robot Control Mate was formerly known as PC Jogging Tools, see 9.1.

Documentation is available from the RobotStudio Help menu after installing the add-in.
5.2 Confirmation when connecting to controller with later RobotWare version

Overview

The user needs to confirm when connecting to a controller with a RobotWare version that is not supported by RobotStudio. Check the About section for the supported RobotWare versions.

5.3 New robot model

There is a new robot model supported by RobotWare 7.0.1 and RobotStudio 2019.5

IRB 910INV IP54/CR (Inverted Scara Clean Room)
6 What’s new in RobotStudio 2019.4

6.1 Search file in Options dialog

Overview

A filter has been added to make it easier to find the option you are looking for in the Options dialog.

Enter text to filter the list options
6.2 IBT 6790: Cable and contactor added

Overview

The cable and contactor board of the IRB 6790 has been added. The contactor position can be moved to fit your robot cell. The cable is flexible and will follow.

Note that you need to Disconnect the simulation model from its file first. Then you can move the contactor using e.g. SetPosition or free-hand move. You need to use Selection Level = Part.
6.3 Trial license for PowerPacs

Overview

With RobotStudio 2019.4, you can request trial licenses for PowerPacs independently of trial licenses for RobotStudio. This means you can try out a PowerPac for free even if you have consumed your trial license for RobotStudio itself and are using a Premium license.

6.4 Support tool available from the Help menu

Overview

In case you need to contact ABB to ask a question or submit a bug report, you may be asked to create a so-called ‘Support Log file’ using the Support Tool. The support tool is now easier to find, since it is available in the Help menu of the File tab.

6.5 Support for RobotWare 5.16

Overview

RobotStudio 2019.4 supports RobotWare 5.16 (in addition to RobotWare 6 and 7).
7 What’s new in RobotStudio 2019.3

7.1 Support for RobotWare 7 and OmniCore

**New robot controller**

RobotWare 7 supports the new OmniCore controller.

**New FlexPendant**

There is a new virtual FlexPendant for OmniCore that is supported by RobotWare 7.

For system requirements, see section 1.2 System recommendation

When installing RobotWare 7, you will get a question whether to install or update also the virtual OmniCore FlexPendant. If you want to install or update it manually, you can do it from the Add-ins tab. Expand the RobotWare 7 node, and select “Install...” from the context menu of the FlexPendant Apps node, see screenshot below.

**New user interface for User Authentication System (UAS)**

The user interface for UAS has been remade.

**Support KeepStartPath and KeepEndPath for fine points**

New options for move instructions in RobotWare 7
7.2 New robots
The following new robots are supported by RobotWare 7 and RobotStudio 2019.3.

IRB 910INV (inverted Scara)

IRB 1100

IRB 14050 (Single Arm Yumi)
7.3 Other changes

**Scale geometry**
There is a new function to scale geometry

**Measurement tool - dynamic measurement**
Measurements between objects may follow objects to allow dynamic measurements.

**Project templates for Visual Studio 2019**
New project templates for Online Addins

**New UI to edit poses for mechanisms**
This was only possible in the Mechanism Modeler before

**VR: Verify that RobotStudio and VR uses the same display adapter**
A check has been added to ensure RobotStudio and VR uses the same graphic adapter.
8 What’s new in RobotStudio 2019.1

8.1 Changes to naming and licensing

Changes in version naming

Starting this year, we will introduce a new version naming scheme for RobotStudio. It will be based on the current year and remove any reference to RobotWare. This will facilitate communication with our support teams and be more readable both for us and for you. This new naming does not change the fact that RobotStudio will continue to support all released versions of RobotWare 5, 6 or 7. It will also allow us to release RobotStudio independently of RobotWare for more frequent quality and feature updates.

Changes in licensing

With RobotStudio 2019 we need to upgrade a vital part of our licensing system in order to:

- Reduce illegal use of our trial licenses
- Prepare our systems for new features
- Ensure a modern and maintainable architecture

Current licenses will continue to run as usual on RobotStudio up to version 6.08 until their expiry. Any future licenses purchased will only be compatible with RobotStudio 2019 and up. On renewal we will ask you to update RobotStudio to its latest version. Finally, current users will be receiving an email in the next few days with new license keys compatible with RobotStudio 2019. If you wish to work immediately on the latest version of RobotStudio 2019, you can! Once again, these new license keys will not affect your current work or existing licenses that will continue to run as usual.

You can always contact ABB Robotics software licensing support via e-mail: softwarefactory_support@se.abb.com, or, your local ABB Robotics Service representative for assistance with this transition process.

8.2 The term ‘System’ replaced by ‘Virtual Controller’

Overview

In previous versions of RobotStudio, the term System was used to denote the set of RobotWare files that defined the virtual controller setup for the currently used robot and its RobotWare options. This term has been replaced by Virtual Controller whenever possible. The function as such is the same.

This applies to several places in the user interface and the user documentation. Also the folders named System in the user documents location and in Solution folders have been renamed.
8.3 RobotWare must be installed separately

Overview

RobotWare is no longer installed with RobotStudio, but have to be installed separately. RobotWare can be downloaded and installed from the RobotApps page in RobotStudio, see screenshot below.

![RobotWare Installation Screenshot]

8.4 Other changes

Overview

The linked document describes all new features and changes to RobotStudio 2019.1

9 Late changes

9.1 Late changes in RobotStudio 2019.5.3

PC Jogging Tools is now called Robot Control Mate and is available in RobotApps

Robot Controller Mate was available as an integrated feature PC Jogging SCARA in RobotStudio versions 2019.4 and 2019.5. For earlier or later versions of RobotStudio, this feature is provided as an add-in which must be installed from RobotApps. The earlier version is called PC Jogging and the its now called Robot Control Mate.

9.2 Late changes in RobotStudio 2019.4

Configuration of safe signals for PROFIsafe F-Device moved to the I/O Engineering Tool

Signals for PROFIsafe F-Device are no longer configured in the Safe IO Configurator of Visual SafeMove. Instead, the signal configuration has moved to the I/O Engineering Tool. Signals for PROFIsafe F-Host has been configured in the I/O Configuration Tool since earlier. The change means that signals for PROFIsafe F-Host and F-Device are configured in the same way.

RobotStudio ≤ 2019.3

RobotStudio ≥ 2019.4

The I/O Engineering Tool can be opened from the Configuration menu of the Controller tab.

The safe safe signals are configured by selecting the safe modules for safe inputs and outputs in the tree view to the left. The safe modules are indicated by a yellow icon in the tree view. Then signals are added in the table in the document window to the right. See screen shots below.
When signal configuration is completed, you can write the configuration to the controller from the I/O Engineering tool or from Visual SafeMove.

9.3 Late changes in RobotStudio 2019.3

New version of the CAD converters

   The version of Spatial ACIS InterOp used for the CAD converters has been updated to version 2019 1.0.2 (SP2). By adopting the latest version of InterOp, RobotStudio automatically provides best-in-class interoperability for the latest 3D modeling formats ensuring that new data and features are available.

9.4 Late changes in RobotStudio 2019.2

CPU Load removed from Signal Analyzer

   The CPU Load signal has been removed from the Signal Analyzer. The reason is that the CPU Load measurements are hard to interpret for the end user. The IRC5 robot controller is an event based system with mixed hard, soft, and non real-time components. There are rare cases where you can identify a problem using the CPU load, but this requires deep knowledge of internal priorities and implementations in the controller software. Furthermore, the CPU Load signal is a statistical measurement with low sample rate and low resolution. In addition, 100% CPU load is normal in many cases for operations like Program Save, Backup, CFG-load, System Diagnostics, etc. This is not a sign of poor performance, to the contrary, this is by design. The controller uses the CPU to do all non real-time critical tasks as quickly as possible. System real-time performance (Motion, IO, Rapid) is controlled by other means.

   This may not be intuitive for all users which may believe that high CPU load is the cause when issues arise with e.g. robot performance or I/O communication.

New version of the CAD converters

   The version of Spatial ACIS InterOp used for the CAD converters has been updated to version 2019 SP1. By adopting the latest version of InterOp, RobotStudio automatically provides best-in-class interoperability for the latest 3D modeling formats ensuring that new data and features are available.

Improvements for simulation and programming of conveyor tracking

   Simulation of conveyor acceleration. The acceleration and deacceleration of the simulated conveyor can be set in the Motion tool of the conveyor. The acceleration value is zero by default but can be changed by the user. This can be valuable to prevent the controller error Geometrical Interpolation Error caused by too high acceleration of the conveyor.
Teaching targets for track mounted robot with conveyor tracking. A limitation in RobotStudio caused incorrect external axis values for the track motion and conveyor to be taught for Teach Target and Teach Move Instruction. This has been fixed in RobotStudio 2019.2.

When a track mounted robot is configured to follow the conveyor, i.e. the system configuration parameter Track Conveyor with Robot = No, then the external axis value for the conveyor is used by the robot controller. In this case, the conveyor value is used to offset the track motion so that the difference between the track motion and the conveyor is maintained. This is the only case where the conveyor position in the robtarget is used.

View robot at target and Jump to target/Move Instruction for track mounted robots with conveyor tracking. The view and jump functions has been enhanced to take the external axis value for the conveyor into account.
RobotWare not installed with RobotStudio

RobotWare is not longer installed with RobotStudio for the following reasons:

- RobotStudio works with any version of RobotWare between 5.06 and 7.0.
- RobotStudio is sometimes released independently of RobotWare.
- RobotStudio is forwards compatible with RobotWare revisions within a specific version, i.e. RobotStudio 2019.3 supports any revision of RobotWare 7.0.
- There are many RobotWare versions available, and it is not certain that the specific version needed for a particular user matches the one that comes with RobotStudio.
- Any version of RobotWare can be downloaded and installed from the RobotApps page within RobotStudio.

The SLP Distributor must be updated

The software component SLP Distributor that manages the network licenses for the School and Partner editions must be updated to support license for RobotStudio 2019. When updated, it can handle license for both RobotStudio 6.x and RobotStudio 2019 in parallel.

The updated component is available in the Utilities folder of the download package for RobotStudio 2019.

Prevent user from running the msi-installer

When installing RobotStudio, the file setup.exe must be used and not the msi-file (ABB RobotStudio 2019.2.msi). The reason is that the setup-file ensures that the necessary prerequisites are installed. Otherwise, RobotStudio will fail due to rise to e.g. license errors. To prevent users from mistakenly installing RobotStudio with the msi, it has been blocked and cannot be executed. The following error message will be presented.
10 CAD import formats and versions

Overview

This section describes the supported CAD formats and versions.

CAD formats

The table below lists all formats and versions supported by RobotStudio.

<table>
<thead>
<tr>
<th>Format</th>
<th>File extensions</th>
<th>Option required</th>
</tr>
</thead>
<tbody>
<tr>
<td>3DStudio</td>
<td>.3ds</td>
<td>-</td>
</tr>
<tr>
<td>ACIS, reads versions R1 - 2019 1.0, writes versions R18 - 2019 1.0</td>
<td>.sat, .sab, .asat, .asab</td>
<td>-</td>
</tr>
<tr>
<td>CATIA V4, reads versions 4.1.9 to 4.2.4</td>
<td>.model, .exp, .session</td>
<td>CATIA</td>
</tr>
<tr>
<td>COLLADA 1.4.1</td>
<td>.dae</td>
<td>-</td>
</tr>
<tr>
<td>DirectX writes 2.0</td>
<td>.x</td>
<td>-</td>
</tr>
<tr>
<td>DXF/DWG, reads versions 2.5 - 2019</td>
<td>.dxf, .dwg</td>
<td>AutoCAD</td>
</tr>
<tr>
<td>FBX writes version 7.5</td>
<td>.fbx</td>
<td>-</td>
</tr>
<tr>
<td>IGES, reads up to version 5.3, writes version 5.3'</td>
<td>.igs, .iges</td>
<td>IGES</td>
</tr>
<tr>
<td>Inventor, reads V6 – V2019</td>
<td>.ipt, .iam</td>
<td>Inventor</td>
</tr>
<tr>
<td>JT, reads versions 8.x, 9.x and 10 and 10.2</td>
<td>.jt</td>
<td>JT</td>
</tr>
<tr>
<td>LDRAW, reads version 1.0.2</td>
<td>.ldr, .ldraw, .mpd</td>
<td>-</td>
</tr>
<tr>
<td>NX, reads versions NX 11 – NX 1847</td>
<td>.prt</td>
<td>NX</td>
</tr>
<tr>
<td>OBJ</td>
<td>.obj</td>
<td>-</td>
</tr>
<tr>
<td>Parasolid, reads versions 9.0.* – 31.1.x.</td>
<td>.x_t, .xmt_txt, .x_b, .xmt_bin</td>
<td>Parasolid</td>
</tr>
<tr>
<td>Pro/E / Creo, reads versions 16 – Creo 6.0</td>
<td>.prt, .prt.<em>, .asm, .asm.</em></td>
<td>Creo</td>
</tr>
<tr>
<td>Solid Edge, reads versions V18 – ST11</td>
<td>.par, .asm, .psm</td>
<td>SolidEdge</td>
</tr>
<tr>
<td>SolidWorks, reads versions 2003 – 2019</td>
<td>.sidprt, .sldasm</td>
<td>SolidWorks</td>
</tr>
<tr>
<td>STEP, reads versions AP203, AP214, AP242, writes version AP214</td>
<td>stp, step, p21</td>
<td>STEP</td>
</tr>
<tr>
<td>STL</td>
<td>Stl</td>
<td>-</td>
</tr>
<tr>
<td>VDA-FS, reads 1.0 and 2.0, writes 2.0</td>
<td>vda, vdafs</td>
<td>VDA-FS</td>
</tr>
<tr>
<td>VRML, reads VRML2 (VRML1 not supported)</td>
<td>wrf, vrm1, vrm12</td>
<td>-</td>
</tr>
</tbody>
</table>
# 11 Corrections

## Overview

This section lists the corrections made.

### 11.1 Corrections made in 2019.5.

#### PDDs

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related to 12288</td>
<td>Visual SafeMove - Different safety checksum between Robot Studio versions</td>
</tr>
<tr>
<td></td>
<td>When opening a safety configuration file with an earlier file format in Visual SafeMove the checksum was changed even though no changes was made in to the configuration in the user interface.</td>
</tr>
<tr>
<td>12344</td>
<td>Improvement - Restore state when Visual SafeMove receives the motors-on signal from the controller.</td>
</tr>
<tr>
<td></td>
<td><em>The visibility state of geometries are restored when Visual SafeMove receives the motors-on signal from the controller.</em></td>
</tr>
</tbody>
</table>

### 11.2 Corrections made in 2019.5.4

#### PDDs

No corrections.

### 11.3 Corrections made in 2019.5.3

#### PDDs

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related to 12288</td>
<td>Visual SafeMove - Different safety checksum between Robot Studio versions</td>
</tr>
<tr>
<td></td>
<td>When opening a safety configuration file with an earlier file format in Visual SafeMove the checksum was changed even though no changes was made in to the configuration in the user interface.</td>
</tr>
</tbody>
</table>
### 11.4 Corrections made in 2019.5.2

#### PDDs

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>12033</td>
<td>RobotStudio Add-In based on PC-SDK causes significant problems since RS2019.3&lt;br&gt;&lt;br&gt;When using Controller.Connect as Standalone connection type, the Logon() does not work</td>
</tr>
<tr>
<td>ID</td>
<td>Title</td>
</tr>
<tr>
<td>------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>11783</td>
<td>Multiple floors in RobotStudio</td>
</tr>
<tr>
<td></td>
<td><em>In some cases when moving up/down in VR additional floors were created.</em></td>
</tr>
<tr>
<td>11791</td>
<td>SIMITConenction - not possible to set/reset AS1 &amp; AS2 signals</td>
</tr>
<tr>
<td>11816</td>
<td>German translation error for &quot;SetGo&quot; popup description</td>
</tr>
<tr>
<td></td>
<td><em>An error in the translation to German.</em></td>
</tr>
<tr>
<td>11840</td>
<td>Create solution with system from backup fails in first run</td>
</tr>
<tr>
<td></td>
<td><em>Depending on the path of the VC it was in some cases not possible to create a system from backup.</em></td>
</tr>
<tr>
<td>11919</td>
<td>Pack n go issue</td>
</tr>
<tr>
<td></td>
<td><em>In some combinations of RobotStudio and anti-virus software the users where unable to unpack a Pack n go.</em></td>
</tr>
<tr>
<td>11959</td>
<td>Open station error</td>
</tr>
<tr>
<td></td>
<td><em>A station had duplicate references to an rslib. This made it impossible to open the station.</em></td>
</tr>
<tr>
<td>11979</td>
<td>ThrowKeyNotFoundException</td>
</tr>
<tr>
<td></td>
<td><em>An exception was thrown when trying to open a corrupt station. RobotStudio will not try to repair the station before loading.</em></td>
</tr>
<tr>
<td>11999</td>
<td>System cannot be created with a combination of IRB5500(configB) and ElevRail(ConfigB)</td>
</tr>
<tr>
<td>12023</td>
<td>Remove internal geometry</td>
</tr>
<tr>
<td></td>
<td><em>Remove internal geometry should only remove geometry not visible from the outside but in some cases geometry parts that are visible where also removed.</em></td>
</tr>
</tbody>
</table>

### 11.7 Corrections made in 2019.4 SP1

#### PDDs

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDD11957</td>
<td>I/O Engineering Tool: Modules for PN Internal Device not updated when changed.</td>
</tr>
<tr>
<td></td>
<td><em>The tree view showing the size and type of the PN Internal Device Module was not updated correctly after it had been changed.</em></td>
</tr>
<tr>
<td>PDD11960</td>
<td>Visual SafeMove: Not possible to protect signals, but leave the module unprotected.</td>
</tr>
<tr>
<td></td>
<td><em>When using protected elements, it must be possible to protect only the signals, but not the module information. This was not possible in 2019.4.</em></td>
</tr>
<tr>
<td>PDD11961</td>
<td>I/O Configurator: The integer value of the source or destination address has incorrect limits (1 to 1022 instead of 1 to 65534)</td>
</tr>
<tr>
<td></td>
<td><em>The limits of the source and destination address of a safe module was incorrect.</em></td>
</tr>
</tbody>
</table>

### 11.8 Corrections made in 2019.4

#### PDDs

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>10890</td>
<td>Exception when restoring backup due to inadequate error handling</td>
</tr>
<tr>
<td>11392</td>
<td>IO Engineering tool: Wrong error message if unauthorized user try to write IO config</td>
</tr>
</tbody>
</table>
VrHandController SmartComponent doesn't respond

The VrHandController component doesn't give any feedback when the trigger is pushed on the VR hand controller.

Collision Avoidance: Collision geometries not updated in Collision Avoidance configuration tool when robot moves.

Online Monitor: Incorrect interpretation of base frame for MultiMove system with Collision Avoidance

There was a mismatch between the Collision Avoidance geometries and the robot model in Online Monitor for MultiMove systems.

Signal Analyzer: Problem with trimming of signals

When trimming a recording the signal quantity was lost which caused RobotStudio to interpret the signal as unitless.

Licensing: RobotStudio 2019 License Storage not initialized

In certain circumstances, there may be a problem with the RobotStudio license. In these cases RobotStudio will display a message whereby the user can allow RobotStudio to fix the problem. Unfortunately, RobotStudio was not always able to fix the problem. This has been improved in 2019.4 so that RobotStudio will be able to fix the problem in more cases.

OmniCore virtual FlexPendant: Does not support Windows 7

The OmniCore virtual FlexPendant is a Windows 10 application and will not run on Windows 7. In RobotStudio 2019.4, the user will get an error message when trying to start the OmniCore virtual FlexPendant on Windows 7.

German translation error "Projektmappe" not "Lösung"

Incorrect translation of the term "Solution" in german language.

11.9 Corrections made in 2019.3

PDDs

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>10469</td>
<td>Visual SafeMove: Safety configuration is not restored to virtual controller when using when opening station using Unpack &amp; Work. This is solved by adding an option to the Unpack &amp; Work wizard that can be selected to restore the safety configuration when the station is opened.</td>
</tr>
<tr>
<td>10965</td>
<td>Add-Ins tab / RobotApps: There is no scroll bar in the properties window that describes that selected app.</td>
</tr>
<tr>
<td>11202</td>
<td>RAPID Sync: Sync to station fails unless robdata module is open. Values are not updated otherwise.</td>
</tr>
<tr>
<td>11316</td>
<td>IRB5500 Elevated Rail - Fails to load mechanism after adding existing system.</td>
</tr>
<tr>
<td>11403</td>
<td>MultiMove tool: Path Config function fails for a particular setup</td>
</tr>
<tr>
<td>11441</td>
<td>Configuration Editor / Area Motion / Type Robot / : Items are missing in the list of ROBOTs and SINGLEs for attribute &quot;Base Frame Moved by&quot;.</td>
</tr>
<tr>
<td>11505</td>
<td>Display problems in the Robot Studio in high res displays: The &quot;Offset position&quot; tool does support 4K displays.</td>
</tr>
<tr>
<td>11511</td>
<td>Visual SafeMove: Signal names treated as case sensitive in Visual SafeMove configuration tool as opposed to the safety controller that treats them as case insensitive.</td>
</tr>
<tr>
<td>11541</td>
<td>Set Local Origin: Strange behavior for certain parts.</td>
</tr>
<tr>
<td>11553</td>
<td>Record to Viewer: Invalid gltF-file generated from RobotStudio when recording simulation.</td>
</tr>
<tr>
<td>11562</td>
<td>Pack &amp; Go: RobotStudio will create a corrupt Pack &amp; Go file for long folder paths.</td>
</tr>
</tbody>
</table>
The menu of migration steps incorrectly displays the License Migration tool option in RobotStudio 2019.1.

Virtual Controller is not starting after upgrading a particular station from RS6.0.8 to RS2019.1. Checkbox for resetting VCs added to Unpack&Work wizard.

Physics: Station fails to open after upgrading a from RS6.0.8 to RS2019.1. Problem related to physics objects and their properties.

Conveyor Tracking / Create connection: RS 2019.2 Fatal Error when creating connection for Conveyor

Motion Configuration aka Edit System: The dialog box is empty, i.e. no data displayed after having deleted old and added new virtual controllers.

Virtual Reality: Problems when jogging robot and finetuning targets

CAD Conversion: CAD Converter fails when CATIA installed in same PC due problems with shared components.

Online Monitor: Online Monitor fails for controller with certain setup of track motion.

Checkbox for resetting VCs added to Unpack&Work wizard.

Physics: Station fails to open after upgrading a from RS6.0.8 to RS2019.1. Problem related to physics objects and their properties.

Conveyor Tracking / Create connection: RS 2019.2 Fatal Error when creating connection for Conveyor

Motion Configuration aka Edit System: The dialog box is empty, i.e. no data displayed after having deleted old and added new virtual controllers.

Virtual Reality: Problems when jogging robot and finetuning targets

CAD Conversion: CAD Converter fails when CATIA installed in same PC due problems with shared components.

Online Monitor: Online Monitor fails for controller with certain setup of track motion.

11622

Virtual Reality: VR fails if headset configured to run on different graphics adapter as screen. (We have added a check in RobotStudio to verify that VR and RS use the same graphics adapter to prevent this error from happening.)

11687

Visual SafeMove: RobotStudio may incorrectly reports an error of the safe IO configuration when reading safety configuration from controller if IO Configurator has not been opened.

11692

EPS Wizard: The EPS wizard fails if a joint value is outside its limits.

11.10 Corrections made in 2019.2

PDDs

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>10416</td>
<td>Conveyor Tracking: The error “Geometric Interpolation Failed” caused by instantaneous acceleration.</td>
</tr>
<tr>
<td>10588</td>
<td>Conveyor Tracking with Rail Tracking: The functions “Jump to Target” and “View to Target” fails</td>
</tr>
<tr>
<td>10923</td>
<td>RAPID Editor: Wrong help function opened in RobotStudio when browsing RAPID code in controller tab</td>
</tr>
<tr>
<td>11095</td>
<td>Conveyor Tracking with Rail Tracking: Incorrect external axis value stored for conveyor when teaching position</td>
</tr>
<tr>
<td>11186</td>
<td>RAPID Watch: Array values sometimes presented as &quot;Unknown&quot;</td>
</tr>
<tr>
<td>11246</td>
<td>Visual SafeMove: Elbow geometry incorrectly visualized for door opener robot IRB 5350</td>
</tr>
<tr>
<td>11391</td>
<td>Physics simulation: Exception when opening station due to incorrect physics behavior if component group items connected through physics</td>
</tr>
<tr>
<td>11412</td>
<td>Visual SafeMove: Gravity parameters (gravity alpha, gravity beta) incorrectly interpreted for when visualizing Coordinated MultiMove robots.</td>
</tr>
<tr>
<td>11509</td>
<td>Mechanisms: Incorrect motion for mechanisms with dependencies between expressions</td>
</tr>
<tr>
<td>11520</td>
<td>Visual SafeMove: Cannot download configuration for system with Profisafe F-host unless I/O Engineering tool has been opened.</td>
</tr>
<tr>
<td>11540</td>
<td>Station Logic: Bad performance issue when opening the Design tab for stations with may Smart Components and connections</td>
</tr>
<tr>
<td>11561</td>
<td>Installation: License server cannot be specified for command line installation C:\&gt;setup.exe /s /v&quot;/qn ADDLOCAL=ALL LICENSE_SERVER=my_lic_server&quot;</td>
</tr>
<tr>
<td>11579</td>
<td>Licensing: PC cannot be renamed after installation, but before activation of license</td>
</tr>
<tr>
<td>11583</td>
<td>Solution cannot be created when whitespace is used at the end of the solution name</td>
</tr>
</tbody>
</table>
Other changes

The CAD Converter for the STEP format was not part of the Partner edition for 2019.1
This has been fixed in 2019.2 so that the STEP converter is part of the Partner Edition.

The Station Viewer caused parts to move unexpectedly.
In RobotStudio 2019.1, a problem of the Station Viewer caused moving objects to move unexpectedly. This has been fixed in 2019.2.

11.11 Corrections made in 2019.1

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>9276</td>
<td>Visual SafeMove: The function to automatically generate a zone fails if two geometries are used for the upper arm.</td>
</tr>
<tr>
<td>9671</td>
<td>Signal Analyzer: Cannot distinguish joint “J1” from different mechanical units in Excel report.</td>
</tr>
<tr>
<td>9672</td>
<td>Signal Analyzer Online: Initial values of motion signals not visualized in beginning of recording.</td>
</tr>
<tr>
<td>9824</td>
<td>The function Move Along Path fails for paths defined as LOCAL</td>
</tr>
<tr>
<td>10147</td>
<td>Online Monitor: Zoom in / Zoom out commands does not work in Online Monitor.</td>
</tr>
<tr>
<td>10192</td>
<td>Failed to save station, when saving to StationBackups folder.</td>
</tr>
<tr>
<td>10360</td>
<td>Unable to open HOME folder for virtual controllers</td>
</tr>
<tr>
<td>10719</td>
<td>Station Viewer: Unable move forward in simulation with arrow keys</td>
</tr>
<tr>
<td>10736</td>
<td>Physics cable creation not working</td>
</tr>
<tr>
<td>10913</td>
<td>3D attachment jumps when simulations stopped manually</td>
</tr>
<tr>
<td>11021</td>
<td>Mirror Path: Exception if “Receiving Robot” is not set.</td>
</tr>
<tr>
<td>11093</td>
<td>RAPID Editor / Modify Position: External axis value are deleted</td>
</tr>
<tr>
<td>11094</td>
<td>Joint jog: Lock TCP not using correct tooldata for IRB 5350</td>
</tr>
<tr>
<td>11133</td>
<td>Create backup: Fails for long file paths</td>
</tr>
<tr>
<td>11141</td>
<td>Problems when using RobotWare 5.13 or lower.</td>
</tr>
<tr>
<td>11204</td>
<td>Physics cable is getting longer instead of shorter by using the “Shorter” function</td>
</tr>
<tr>
<td>11215</td>
<td>Smart Components / Station Logic: Fatal error when connecting output of LogicGate to I/O input</td>
</tr>
<tr>
<td>11228</td>
<td>Smart Components / Station Logic: Fatal error when connecting output of LogicGate to I/O input</td>
</tr>
<tr>
<td>11219</td>
<td>Pack &amp; Go / Unpack &amp; Work: File size very large if RobotWare Add-In MotorsAndGearUnits added to virtual controller</td>
</tr>
<tr>
<td>11226</td>
<td>Jobs / Backup: Fails if white-space included if white space added to beginning or end of name string</td>
</tr>
<tr>
<td>11270</td>
<td>RAPID Path Editor: Unable to edit SpotL instructions</td>
</tr>
<tr>
<td>11322</td>
<td>Visual SafeMove: Unable to restore safety configuration if LockInfo and ValidationInfo was in wrong order in safety configuration file.</td>
</tr>
<tr>
<td>11332</td>
<td>Smart Component Design View / Signals and Connection: Missing child Signals in Expose Child Signal dialog</td>
</tr>
<tr>
<td>11335</td>
<td>YuMi AbsAcc Recovery routine is missing in RW6.08.01</td>
</tr>
<tr>
<td>11385</td>
<td>Visual SafeMove: SafeMove Report shows internal Function Mappings which are not configured by the user</td>
</tr>
<tr>
<td>11391</td>
<td>Physics: Exception when opening station if physics joints are configured between parts of a component group.</td>
</tr>
<tr>
<td>11411</td>
<td>Collision avoidance configuration tool: Bad performance when adding many large objects</td>
</tr>
</tbody>
</table>
12 Known Limitations

Overview
This section describes known limitations in RobotStudio.

12.1 Visual SafeMove

*Visibility state after violation is not restored for the second upper arm geometry*

Only the visibility state of the first geometry of the upper arm enclosure is restored after a violation is reset. If there are more geometries of the upper arm, their visibility state is not restored when a violation is reset.

*The safety controller is not forwards compatible*

When writing a safety configuration file of a later version than the current safety controller image, then RobotStudio will generate an error of type “C00FFFE: Unknown error (0xC004FFFE)LoadSafetyConfigurationFile”. (Note that this error may occur for other reasons as well and is thus unique to this case).

*The function Get vectors from active tool reads values from the robot*

The idea behind this function is to read the data from the currently active tool of the robot in order to define a corresponding SafeMove Tool in the safety configuration. That is the reason why the tool information is read from the robot and not the safety controller. The tools of the safety configuration are visible the Visual SafeMove itself and does not need a special function to be retrieved.

Protected checksum may change when upgrading RW from 6.04.0x to 6.05 or 6.06

The protected checksum will change if the input and output modules of the internal device is protected. The reason is that two attributes change order.

No visualization of Safe Range for external axes in Visual SafeMove for SafeMove Basic or Pro

When Safe Range is used to limit the axis range of an external axis such as a track motion, there will be no visual indication of the actual range in the graphic view.

Visual SafeMove windows can be re-opened from the Quick Access Toolbar menu

Any windows that are closed can be re-opened using the Quick Access Toolbar menu, as the command Default Layout does not recover these windows.

SafeMove Tool Zone visualization in Online Monitor for robots with external axes

Only TCP robots and track mounted robots will be visualized in the Online Monitor, no other external axes or positioners.

As a consequence, the Online Monitor may show the robot in a non-violating position, even though the safety controller has detected a safety violation and stopped the robot.

12.2 Online

Individual RAPID tasks cannot be stopped for RobotWare 5.60 and later

When running multitasking systems, it is not possible to start and stop individual tasks with the dropdown menu of the task node in the Controller browser. This is due a restriction introduced with RobotWare 5.60 and later.

However, from RobotWare 6.03 onwards, then RAPID tasks to execute or to stop can be selected from RobotStudio RAPID tab.
**FlexPendant Viewer running with automatic reloading**

When having FlexPendant Viewer running with automatic reloading of the screens and at the same time jogging the robot with the joystick the robot jogging might halt when the FlexPendant Viewer reloads.

**12.2.1 Online – Paint**

**Backup for Paint systems does not create backup of the PIB for IRC5P with RobotWare 5.xx**

The Backup function of RobotStudio does not create a backup of the PIB board of the IRC5P system when running RobotWare 5.xx.

**Workaround**: Create the backup of the PIB board with the FlexPaint Pendant using an USB-stick.

**Go Offline does not work for Paint systems**

The Go offline function will not create a working Virtual controller system for Paint system unless the Paint package I/O option is set to Simulated.

**12.2.2 Online – Integrated Vision**

**Installation error when having previous versions of RobotStudio or Insight Explorer**

If you have a previous version of RobotStudio or Cognex In-Sight software installed, installing a new version of RobotStudio may result in the following error message

```
Module C:\Program Files (x86)\Common Files\Cognex\In-Sight\5.7.1674.0\CvsInSightDisplay.ocx failed to register. HRESULT -2147220472.
Contact your support personnel.
```

**Workaround**: To correct the issue, open Windows Settings -> Apps -> Apps & features, select the current ABB RobotStudio 2019.x, select Modify, and step through the installation wizard and select Repair. Alternatively, uninstall and reinstall RobotStudio.

**Note**: Only one version of the In-Sight Display Control can be registered at a time, and this is always the latest version installed. Although older versions of RobotStudio or In-Sight may seem to function with this version installed, their compatibility with this version is not guaranteed.

**RobotStudio may hang for up to 60 seconds when configuring jobs with PatMax 1-50**

The user interface of RobotStudio may freeze for up to 60 seconds when configuration Integrated Vision jobs with the tool PatMax 1-50.

**Workaround**: Use PatMax 1-10 instead.

**Remaining error – New Emulators**

New camera models have been added to the camera emulator option in RobotStudio 6.04.01. Some of these new models are not yet fully compatible. Our recommendation is to choose a camera model from the 7000 series which is fully compatible with Firmware version 4.10.2.

**Emulated cameras not discovered when controller in Motors On**

For RobotWare 5.61 onwards, the camera discovery mechanism is disabled when the controller is in Motors On. As a consequence, the camera nodes will not appear in the controller browser.

**Workaround**: Switch to Manual Reduced Speed and use the Refresh command on the Integrated Vision node in the browser to make the cameras appear.
Information – Camera firmware version and update
The minimum firmware version to be used with Integrated Vision is 4.08. If this version is not available for a specific camera model, then the newest version available shall be used.

There are two important things to know before upgrading a sensor:

- The user must make sure to first backup the files on the camera. This can be done using the Rapid snippets for camera backup/restore, or the FlexPendant Explorer.
- The latest available firmware version may vary across sensor types. However, when the firmware update utility presents the latest available version it shows the firmware with the highest version number which may not apply to the sensor to be updated. However, the appropriate firmware will be applied.

Information – The spreadsheet view
The spreadsheet view is not enabled when editing in the following modes “Add part location tool”, “Add part inspection tool”. Before entering the spreadsheet mode click for example “Setup Image” or Output to Rapid.

Information – Calibration board without fiducial
When using the calibration boards, checkerboard or board with dots, the user must select the preferred origin by clicking and accepting (press enter) three points on the board. Only after these three points have been selected is it possible to click “calibrate” to execute the calibration.

Information - Use default camera settings
If the camera is not using default communication settings the result may be that RAPID instructions return error code “Communication Error”. The safest method to get default settings is to go to Connect->Add Sensor Right click and select “Show all sensors”. Select the device to reset and click “Apply factory settings” in the lower right corner. The most important settings are:

- Telnet port: 23
- User: “admin”
- Password: “”

Information – User Credentials
It is now possible to create user profiles with different access levels on the camera. For detailed information about this, please refer to the Integrated Vision User Manual.

Remaining error – Save image on camera
It is not possible to save an image on the camera using “Save Image”. This is by design, but the dialog still allows the user to try to do this. The result is that the image is not saved and no error message is given.

Remaining error - Connect button greyed out for no reason
It may sometimes happen that the “Connect” button is greyed out, with the tooltip saying the camera is not on the correct subnet although the IP settings are OK.

Workaround: Restart the Integrated Vision Add-In.

Remaining error – VC started from Controller->Add controller does not detect cameras
A VC that is started from Controller->Add controller does not detect cameras on the network, even if the VC_network_definition.xml is correctly configured and the firewall is turned off. The reason is that the controller is not able to detect new cameras on the
network when it is in “Motors On” state. When the VC is started stand-alone in RobotStudio it is automatically set to “Motors On” when started.

**Workaround:** To allow it to discover cameras, turn the control panel key to manual mode or launch the VC as part of a station.

**User tip - Removing cameras from configuration**

To remove a configured camera from the list of configured cameras, use the configuration editor. Enter *Configuration>*Communication>*Application Protocols* and remove the desired camera. Perform a warm start to complete the operation.

**User tip – Viewing all cameras present on the network**

*Connect>*Add Sensor* is normally used for setting the IP addresses of sensors that are not currently on the correct subnet (192.168.125.X). Since the dialog shows all cameras “seen” by the PC, this dialog is useful when error tracing camera network problems.

If a camera does not appear on the network using the “Add sensor” dialog as suggested above, it is advisable to cycle the power of the camera. If the camera receives power from the controller, then cycle power by turning the mains switch.

**User tip – Warm start the controller after changing network settings**

Whenever changing the network settings of the camera, either from *Connect>*Add Sensor or *Connect>*Network settings, it is important to warm start the controller. If this is not done, RAPID instructions will give the error “Communication Error” and the FTP-mounted camera disk is not accessible. If DHCP address is used and persist, please try a static address instead.
12.3 Offline

*RobotStudio needs to be restarted to update a modified library instance*

When editing a library file (.rslib) that is used in a currently open station, then RobotStudio needs to be restarted to update the library. Simply re-opening the station is not enough to update the content of the station. Unless RobotStudio is restarted, the old library instance will remain in memory and be loaded even though the underlying file has been updated. This is a known limitation and is expensive to fix. There is a workaround to the problem, which is to restart RobotStudio.

The robot IRB 1600ID 1.55 m / 6 kg replaced by IRB 1660ID 1.55 m / 6 kg in RobotWare 6.04

The robot IRB 1600ID 1.55 m / 6 kg is not available in RobotWare 6.04 and later. It has been renamed to IRB 1660ID 1.55 m / 6 kg. Virtual controller systems for IRB 1600ID 1.55 m / 6 kg based on RobotWare 6.03 cannot be upgraded to RobotWare 6.04 and later. This means that Pack&Go files for this robot based on RobotWare 6.03 cannot be upgraded to RobotWare 6.04 automatically.

**Workaround:** Re-build or modify the virtual controller system to use IRB 1660ID 1.55 m / 6 kg instead when using RobotWare 6.04 or later.

FlexPendant and RAPID applications run with logged in user rights

A FlexPendant or RAPID application running on the virtual controller runs with the rights of the logged-in Windows user. RAPID applications running in a background task will start to execute when the Pack&Go file is opened and FlexPendant applications will start to execute when the user starts the Virtual FlexPendant.

A warning message has been added to the Unpack&Work wizard to make the user aware that only Pack&Go files (.rspag) from trusted sources shall be opened.

Compatiblity of RobotStudio Library and Stations with older RobotStudio versions

RobotStudio is generally **not forwards compatible**, i.e. it is not possible to load stations or libraries created in RobotStudio 6.04 into an earlier version of RobotStudio such as e.g. RobotStudio 5.x, 6.03.02 or earlier. However, RobotStudio is **backwards compatible**, which means stations and libraries created in versions 5.x, 6.03.02 or earlier can be opened in RobotStudio 6.04.

TrueMove path visualization fails for customized zone data.

The TrueMove path visualization function only supports predefined zonedata. It will not work for user defined zonedata.
Backup fails for RobotStudio solutions with SafeMove or Electronic Positioning Switches

Backups are automatically created for virtual controller systems that are part of a RobotStudio solution when saving the station. For virtual controller systems with the RobotWare options SafeMove or Electronic Positioning Switches the backup will fail since these systems contain files that are read-only. As a result, an error message is presented in the output window: “<System name>: Backup failed”. The station will be successfully saved but there will be no backup created.

Workaround: Ignore the error message “<System name>: Backup failed” and create a manual backup whenever needed. The RobotStudio Option “Enable automatic backup of controllers in solution” that is available in” RobotStudio Options -> Robotics -> Virtual Controller” can be de-selected to disable the backup function.

IRB 14000 cannot be combined with any other robot

The function system from layout fails if trying to create a MultiMove system where one robot is an IRB 14000. The reason is that the IRB 14000 cannot be combined with any other robot.

Workaround: Create a separate system for the IRB 14000.

The Work Envelope function does not support IRB 14000

The function is disabled for the IRB 14000 and cannot be activated.

The 2D work envelope fails for certain robot models

As a result, the generated work envelop may appear distorted.

Update of current selection in the 3D graphics window may be delayed

A problem related to the graphics driver has been observed on certain PCs. The problem is that the update of the current selection in the 3D graphics is delayed until the next redraw.

Workaround: Add or un-comment the following line in the file RobotStudio.exe.config

<add key="DoublePresentWorkaround" value="true" />

Failure to open Pack&Go file to same folder the second time

RobotStudio will prevent Pack&Go files to be opened to the same folder a second time if the station contains VC systems with the EPS or SafeMove option. This is by design to prevent the safety controller configuration file to be accidentally overwritten.

Workaround: Remove the write protection manually using Windows Explorer.

Updates of instruction template and code snippets

RobotStudio will not automatically update the user files for instruction templates and code snippets files in the folders:

...\My Documents\RobotStudio\Instruction Templates
...\My Documents\RobotStudio\Code snippets

Workaround: The user has to manually copy the latest files from

%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Instruction Templates,
and
%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Code Snippets
to the data folder.
IO signals configured with access level ‘DEFAULT’

When IO signals are configured with access level ‘DEFAULT’, only input signals are possible to set/reset from the I/O Simulator and I/O Window. To be able to affect also output signals, set the access level to ‘ALL’ for them in the Configuration Editor.

VC does not start with RRI option and GSI folder structure missing.

The VC will hang when started with a system containing the RobotWare option RRI (Robot Reference Interface) if the GSI folder structure is missing.

Workaround: create GSI Folder before starting the VC inside the HOME directory of the system. See the Application Manual for Robot Reference interface for more information.

System in Guard Stop state in Automatic mode after run-time error

Certain run-time errors may cause the controller system to enter Guard Stop state in Automatic mode. This is the same behavior as in a physical robot controller system. This typically happens when a run-time error related to Conveyor Tracking occurs. A simulation cannot be started when the controller is in this state.

Workaround: To reset the controller state, open the Control Panel window and first switch to Manual mode, and then back to Automatic mode.

Path handling of instructions with multiple joint targets

The path functions Rotate, Translate, and Mirror do not work as expected with instructions containing via points as jointtargets. The functions will leave the jointtargets as is. Interpolate Path gives an Unknown Error and Tool Compensation reports an error message.

Event Manager: Simulation cannot be triggered by analog system signals

The event manager only supports analog station signals, not analog system signals

Conveyor Tracking

*Conveyor objects must be re-added for stations created prior to RS 6.05.

When opening stations with conveyor tracking created prior to RobotStudio 6.05, conveyor objects must be re-added.

Incorrect default values for c1Position and c1Speed for RobotWare 5 with the PaintWare option

The default values for the parameters c1Position and c1Speed may become incorrect for a virtual controller system. The symptom is that its attribute values are all zero, see snapshot below.
**Workaround:** Save the following lines to a CFG file named ‘TEMP.CFG’ or similar and load in the virtual controller followed by a restart.

```
EIO:CFG_1.0:5:0::
   #
   EIO_SIGNAL:
      -Name "c1Position" -SignalType "AI" -Unit "CnvIf"
      -SignalLabel "ctPosition" -UnitMap "0-31" -Access "ALL"
      -MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1
      -MaxBitVal 2147483647 -MinLog -21474.8 -MinPhys -1 -MinPhysLimit -1
      -MinBitVal -2147483647
      -Name "c1Speed" -SignalType "AI" -Unit "CnvIf" -SignalLabel "ctSpeed"
      -UnitMap "32-63" -Access "ALL"
      -MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1
      -MaxBitVal 2147483647 -MinLog -21474.8 -MinPhys -1 -MinPhysLimit -1
      -MinBitVal -2147483647
```

### 12.3.2 MultiMove

**MultiMove error: ‘Object reference not set to an instance of an object’**

When the Test Play button is pressed in the MultiMove tool, the following error message may be displayed: ‘Object reference not set to an instance of an object’, but the robot moves and the Status ‘Calculation OK’ is displayed. In addition, when ‘Create Paths’ is pressed the following message is displayed: ‘Can’t create paths : Value cannot be null’, and no paths are created. In the ‘Create Paths Settings’, is the WP TCP drop down empty.

**Reason:** Workobject is not set for the current task

### 12.3.3 External Axis

**Error 50091: ‘Restart not possible’ after warm start of a system with external axis**

When restarting a system with activated mechanical units the activation state is lost. Then the program can no longer be started from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window.

**Workaround:** Reset the program pointer (‘Program Pointer to Main’) before starting the program from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window, or, start the program from the Simulation Play button.
12.3.4 Network Drives and UNC Paths

RobotStudio on computers with roaming user profiles

RobotStudio may fail on PC configurations with roaming user profiles, i.e. when the users’ documents folder resides on a server and not on the local disk.

**Workaround:** Redefine the 'User Project Folder' to a folder on the local disk (File → Options → General → Files&Folders → User Project Folder).

Virtual Controller does not support UNC paths

UNC paths cannot be used to locate Virtual Controller systems. Using UNC paths for VC systems will cause the log message ‘Failed to initialize FW upgrade framework’ to appear when the system starts. Subsequent attempts to work with the VC such as synchronizing RAPID data will fail.

Creating and starting systems located on a network drive

When using a network drive to store RobotStudio data such as RobotWare systems or the RobotWare mediapool, the following problems may occur

- Virtual controller does not start
- Not possible to open Virtual FlexPendant

**Cause:** By default, the .NET Framework does not allow execution of code from a remote file system. This means the application may behave unexpectedly if the media used by the system or the system itself resides on a network share.

**Workaround:** To resolve this, the user must explicitly grant the required permissions:

1. Open the file Virtual FlexPendant.exe.config located in
   C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.61\Bin
2. Add the following lines

   ```xml
   <configuration>
   <startup useLegacyV2RuntimeActivationPolicy="true">
   <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/>
   </startup>
   <runtime>
   <loadFromRemoteSources enabled="true"/>
   </runtime>
   </configuration>
   ```

   The Virtual FlexPendant must be restarted for the changes to take effect.

   For further information, see

**Note**

Windows security settings may prevent the file from being directly edited in the default location. Copy the file to your local Documents folder to edit it. Upon completion, you need to manual copy the file back to its original location.

12.3.5 RAPID

Robtargets that are LOCAL to a PROCEDURE cannot be synchronized with RobotStudio

The RobotStudio synchronization engine that translates 3D data of the station to RAPID code and vice versa does not support robtargets that are declared locally to a procedure.
Workaround: Declare the robtargets as global or local to a module instead.

Robtarget names must be unique in RAPID even if they are LOCAL

RobotStudio requires that robtarget names are unique for the RAPID synchronization to work properly, i.e. you cannot have a global robtarget named pMyTarget1 in module A and a local robtarget with the same name in Module B.

Global robtargets cannot be made local through Synchronization to VC

Global robtargets cannot be changed to local through *Synchronization to VC*, the option is disabled (PDD 3140).

Workaround: Change the robtargets to module local in the RAPID Editor and Synchronize to station.

Error Message: Sync. to Station completed with errors

*Error Message: Sync to Station completed with errors: New data <name> <type> has same name as existing object in same block <routine>.*

When this error message appears, there is a storage type mix-up between data already stored in RS and in the VC. Because of this, and per design, the data is not considered the same data.

Workaround: 1. Ensure all data declarations have the same definition in RS as in RAPID (there is no user interface for this).

2. Sync to station should now work.

3. Sync back to controller, and remember to change the data declarations back to what you want.

12.3.6 Paint

The new conveyor tracking module DSQC2000 is not supported for paint robots.

The new conveyor tracking module DSQC2000 is not supported for paint robots.

Lack of Virtual Controller support for the Paint systems

Paint systems that are configured using the Paint package I/O option Discrete, Compact or Fieldbus, will result in a SysFail state.

Workaround: Re-create the system with the simulated I/O option.

12.3.7 Graphics and Geometry

*Display of working range optimized for furthest reach*

The current algorithm uses a fixed value for joint five which gives the furthest reach for a given tool. The sweep is not optimized to get the shortest reach on the "inside" of the working area.
Enforce selected graphics device for PCs with multiple graphics cards

For best performance when running RobotStudio on a PC with multiple graphics cards, RobotStudio can be configured to use a specified device. By this option you can ensure maximum performance. This is useful for e.g. Lenovo W540 that has both an integrated Intel graphics device and a discrete NVIDIA card.

Open the file RobotStudio.exe.config that is located in the folders

C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio x.y\Bin64
and

C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio x.y\Bin
and uncommen the line

  <add key="GraphicsDeviceType" value="Discrete"/>

Valid values are 'Discrete', 'Integrated' and 'Warp' (software renderer).

Note that there are two different files, one for the 32-bit version, and another for the 64-bit version.

Problems when undoing Boolean operations on Geometry

Undoing a Boolean operation might not succeed. To recover from these problems, you need to delete the items that caused the problem.

12.4 ScreenMaker Limitations

*Numeric controls and decimal separators

To use numeric controls in ScreenMaker on the PC set the decimal symbol to a single period ('.'). Other decimal symbols are not supported and binding values will not work in the Virtual FlexPendant. The behavior on the real FlexPendant is not affected by this PC setting.

*Graphs on secondary screens

To use a Graph on a secondary screen (not the main screen) a custom action is needed. Otherwise, the Graph will not be updated properly.

In the ScreenForm that contains the Graph add a Load event. In this event add an action using Add Action->Advanced->Call Custom Action. Select the Graph control and the UpdateValues action.
*Binding to the Enabled property*

Connecting the `Enabled` property of any control to a BOOL variable or IO signal may not work as expected. The variable or signal may be inadvertently changed leading to unexpected behavior.

Instead, bind to a digital output where the `Access Level` is set to `ReadOnly`.

**A ScreenMaker cannot be deployed a controller with disabled Default User**

Workaround: Enable the Default User.

**NumEditor in ScreenMaker disables the controls in a group box or panel**

If you are using the NumEditor control in a group box or a panel, and that box or panel is enabled by an input signal, then all other controls of that group or panel will become disabled if the editor is opened and closed.

**Button with multiple states in ScreenMaker app do not update the images if button is disabled**

For an app which uses Buttons with multiple states connected to images that change depending on the value of a RAPID variable, then if the button is disabled, the button shows the greyed image of the state which was active when the disabled state was shown the first time.

**ScreenMaker fails for RobotWare 5.12**

ScreenMaker fails to build applications for RobotWare 5.12.

**Workaround:** Update to a later RobotWare version.

**A ScreenMaker application may fail to build if the DPI setting is not set to 100%**

Certain UI controls in ScreenMaker may fail to build correctly if the DPI setting is not set to ‘Smaller – 100%’.

**Symptom:** The error message caused by this problem will read ‘`System.Drawing.Font` does not contain a constructor that takes 2 arguments.’

**Workaround:** Set DPI to 100% on your PC.

**File changes to FlexPendant applications does not load the changes until a FlexPendant reset**

With RobotWare 6.0x the controller's restart will no longer reset the FlexPendant memory. This was part of an effort to improve the restart time of the controller.

This means that after placing a new FlexPendant application file(s) on the FlexPendant unit, you need to manually reset the FlexPendant for it to reload its assets.

To manually reset the FlexPendant you need to use the reset button on the FlexPendant's backside. (See Operating Manual – IRC5 with FlexPendant, 3HAC16590)

**Running Routine with Movement**

RunRoutine Button control does not always work correct when a routine with movements is called.

As a workaround use instructions like StopMove, StorePath, RestorePath and StartMove to control the movements of the robot.

A Trap routine could be called with a normal button control and in the Trap the above instructions can be used to control the movements of the robot.
PictureBox control as a Widget

If a Picture Box control is created as a widget from a Windows 8 operating system, the control is not shown on the FlexPendant. The behavior is fine with any other operating system like Windows 7.
13 RobotWare Compatibility

13.1 General

Supported RobotWare versions
RobotStudio is distributed with the corresponding version of RobotWare and works with RobotWare 5.07 and later. Please check details below.

13.2 RobotWare 5.05 and 5.06 Compatibility
RobotWare 5.05 and 5.06 including revisions thereof are not supported by RobotStudio 5.15 and later versions. Please use the corresponding version of RobotStudio for managing robot controllers with any of these RobotWare versions.

13.3 RobotWare 5.07 Compatibility
RobotWare 5.07 and its revisions of are supported with the following limitations:

General
The location of the program pointer is not updated in the RAPID Editor during program execution.

Offline
A limitation in the versions 5.07.02, 5.07.03, and 5.07.04 of RobotWare may cause the Virtual Controller to System Failure state during I-start on certain computers. The problem is due to the ctrl.bin-file not being correctly created.

Workaround: Create an empty ctrl.bin file in the INTERNAL folder of the controller system, and then perform a warm start.

Note
The problem will reappear if the system is I-started.

The virtual controller does not support RobotWare 5.07.08 and RobotWare 5.07.07.

Online

FlexPendant Viewer does not work RobotWare 5.07

13.4 RobotWare 5.08 Compatibility
RobotWare 5.08 and its revisions of are supported with the following limitations:

Offline
RobotWare 5.08 is not supported.

Workaround: Use RobotWare 5.08.01 or later.

13.5 RobotWare 5.10 Compatibility
RobotWare 5.10 and its revisions of are supported with the following limitations:

Offline
Starting a controller will generate internal UAS error in controller error log.

13.6 RobotWare 5.11 Compatibility
RobotWare 5.11 and its revisions of are supported with the following limitations:
Offline

Linear jogging of a robot across joint values that will cause a change of confdata may fail. For example, if the robot is jogged linearly when joint values is passing 90 degrees for axis 1 may cause the robot to stop or to change configuration.

13.7 RobotWare 5.12 Compatibility

RobotWare 5.12 and its revisions of are supported with the following limitations:

Paint backups from RW 5.12.01 not compatible with RW 5.12.02 or later

Restoring a paint system backup from RobotWare 5.12.01 will cause SysFail for RobotWare 5.12.02 or later

Workaround: Add the following parameters to the configuration files

EIO.CFG:

EIO_SIGNAL:
-Name "doMainInMC" -SignalType "DO" -Unit "SysComm" -UnitMap "44"
-Name "A1HVEnNo" -SignalType "GO" -Unit "SysComm" -UnitMap "150-151"
-Access "ALL"
-Name "A1HVEn" -SignalType "DO" -Unit "SysComm" -UnitMap "155"
-Access "ALL"

EIO_CROSS:
-Res "A1HVEn" -Act1 "HVEnabled"

SYS.CFG:

CAB_TASK_MODULES:
-File "INTERNAL:/pntrapid/T_ROB1/cycinfo.sys" -ModName "cycinfo"
-Task "T_ROB1"
-File "INTERNAL:/pntrapid/csvlkup.sys" -ModName "csvlkup" -AllTask

13.8 RobotWare 5.13 Compatibility

RobotWare 5.13 and its revisions of are supported with the following limitations:

Paint backups from RW 5.12.02, 5.12.03 or RW 5.13 or 5.13.01 not compatible with RW 5.13.02 or RW 5.13.03

There are several changes in the configuration database for I/O (EIO.CFG) and Controller (SYS.CFG) that will cause System Failure if an old backup is loaded. There are also changed in installed RAPID modules. To create a compatible configuration, proceed as follows:

1. Create and start a VC with a RobotWare 5.13.03 system containing the same options as your original backup, but do not load the backup.
2. Save the EIO.CFG and SYS.CFG to file.
3. Compare the saved files with the corresponding files of your backup. (You can use a text file comparison tool for simplification.)
4. Add your system-specific configuration to the general configuration files saved from the 5.13.01-system using a text editor.
5. Replace the files of the original backup with the corresponding modified configuration files.
6. Go through the RAPID modules of the backup and remove the default modules (i.e. those that are not changed by the user).
7. Load the backup and restart the system. You are done.
13.9 RobotWare 5.15 Compatibility

Signal Analyzer Online

The feature Signal Analyzer Online requires RobotWare 5.15.03 or later.

13.10 RobotWare 6 Compatibility

Overview

RobotWare 6.00 and 6.00.01 systems cannot be directly upgraded to RobotWare 6.01. To upgrade a system, you need to create backup and migrate it using the tool ‘Migrate Backup or Folder’, then recreate the system and finally, restore the backup.

For this reason, the functions ‘Unpack&Work’, ‘Go Offline’ and ‘New Solution with Station and Robot Controller – From backup’ are blocked to prevent upgrade from RobotWare 6.00 or 6.00.01 to RobotWare 6.01.

RobotStudio, however, is compatible with both RobotWare 6.00 / 6.00.01 and 6.01.

13.11 General Compatibility Limitations

Safety Configuration

Safety configuration of a track motion IRC5 system equipped with a safety controller of type EPS or SafeMove can be done without the need to read track motion parameters manually when using RobotWare 5.11.01 or later. Encrypted parameters needed by the safety controller will be automatically read by EPS Wizard and SafeMove Configurator, respectively.

Configurations

The feature Configurations for selecting the robot arm configuration (confdata) may fail, or not present all solutions, in some specific circumstances even when the target is reachable if RobotWare 5.14 or earlier is used.

Workaround: Upgrade to RW5.14.01 or later

13.12 ScreenMaker Compatibility

RobotWare

It is possible to use previous RobotWare versions, but with some limitations.

- ActionTrigger will work only on RobotWare 5.12.02 or later.
- The controls Button, TpsLabel and PictureBox controls was modified in RobotStudio 5.13. The property ‘Allow MultipleStates’ of these controls can be accessed from RobotWare 5.13 and later.
- Variant Button will work only on RobotWare 5.14.01 or later
- Conditional Trigger will work only on RobotWare 5.14.01 or later
- Widgets will work only on RobotWare 5.60 or later.

FlexPendant SDK

ScreenMaker should be used with FlexPendant SDK 5.12.02 or later. ScreenMaker allows selection of FlexPendant SDK version when it is launched. If only one version of FlexPendant SDK is available in the system, it is loaded by default.